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Introduction

The pivot table is the single most powerful tool in all of Excel. Pivot tables came along 
during the 1990s, when Microsoft and Lotus were locked in a bitter battle for domi-

nance of the spreadsheet market. The race to continually add enhanced features to their 
respective products during the mid-1990s led to many incredible features, but none as 
powerful as the pivot table.

With a pivot table, you can transform one million rows of transactional data into a 
summary report in seconds. If you can drag a mouse, you can create a pivot table. In 
addition to quickly summarizing and calculating data, pivot tables enable you to change 
your analysis on the fly by simply moving fields from one area of a report to another.

No other tool in Excel gives you the flexibility and analytical power of a pivot table. 
The Power Query tools that debuted between Excel 2013 and Excel 2016 come close 
to the power of a pivot table. You will see some Power Query examples in Chapter 17, 
“Pivoting without a pivot table using formulas, Python, or Power Query,” and Chapter 18, 
“Unpivoting in Power Query.”

What you will learn from this book

It is widely agreed that close to 60 percent of Excel customers leave 80 percent of Excel 
untouched—that is, most people do not tap into the full potential of Excel’s built-in utili-
ties. Of these utilities, the most prolific by far is the pivot table. Despite the fact that pivot 
tables have been a cornerstone of Excel for almost 30 years, they remain one of the most 
underused tools in the entire Microsoft Office suite.

Having picked up this book, you are savvy enough to have heard of pivot tables—and 
you have perhaps even received them on occasion. You have a sense that pivot tables 
provide a power that you are not using, and you want to learn how to leverage that 
power to increase your productivity quickly.

Within the first two chapters, you will be able to create basic pivot tables, increase 
your productivity, and produce reports in minutes instead of hours. Within the first seven 
chapters, you will be able to output complex pivot reports with drill-down capabilities 
and accompanying charts. By the end of the book, you will be able to build a dynamic 
pivot table reporting system.
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What is new in Microsoft Excel’s pivot tables

Microsoft introduced two new array functions to make it easier to replicate a pivot table 
using a formula: PIVOTBY and GROUPBY. One advantage of formulas over pivot tables 
is that formulas will automatically recalculate when the underlying data changes. There 
are times when you are creating dashboards for the manager three levels up, and you 
really can’t count on them to know to click the Refresh button on the pivot table menu. 
In these cases, the PIVOTBY function can make sure your dashboard is up to date.

For several years, Microsoft offered the Analyze Data feature where you could often 
create a pivot table just by asking a question about your data. The Analyze Data fea-
ture is tested and reliable and will always produce a reliable result. For this edition of 
the book, a brand new Copilot feature is available in Excel. You have to pay extra. It will 
often produce a report as accurate as the same report as Analyze Data. However, it will 
sometimes produce the wrong report or an inaccurate report. At the very least, having 
Copilot on the other side of a paywall should make you appreciate the superior Analyze 
Data feature that is freely available in Microsoft 365.

You can now create a pivot table while using Excel Online. It does not offer all the 
features of Excel for Windows, but being able to create a pivot table in Excel Online is a 
giant leap for the online version of Excel. It was just few years ago that I wrote in the pre-
vious edition of this book that Excel Online would never allow you to create pivot tables, 
and now, they do it. You can’t tweak them like you can in Windows, but you can create 
pivot tables.

Office 365 offers a new Analyze Data feature that is powered by Artificial Intelligence. 
Select a data set with up to 250,000 cells and ask Excel to analyze the data. Excel will  
suggest about 30 interesting analyses, including several pivot tables.

The Analyze Data feature allows you to ask a question about your data. There is a 
fairly high chance that the answer will be provided as a pivot table or a pivot chart. So, 
Analyze Data and Ask a Question become new entry points for creating pivot tables.

If you missed the 2019 edition of this book, these features were new since Excel 2016:

■■ You can specify default settings for all future pivot tables.

■■ The automatic date grouping introduced in Excel 2016 pivot tables can now be 
turned off. A mix of empty cells and numeric cells will be treated like a numeric 
column and will default to Sum instead of Count.

■■ Power Pivot is now included in all Windows versions of Excel 2019 and Office 365.
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Case study: Life without pivot tables
Say that your manager asks you to create a one-page summary of a sales database. They 
would like to see total revenue by region and product. Suppose you do not know how to 
use pivot tables. You will have to use dozens of keystrokes or mouse clicks to complete 
this task.

This sample data set (included with the download files for the book—see page 
xxxii)—has headings in row 1, data in rows 2 through 564, and columns in column A 
through column I.

First, you have to get a sorted, unique list of products down the left side of the sum-
mary report and a sorted, unique list of products across the top. In the past, this might 
involve an Advanced Filter or the Remove Duplicates command. But today, it is easiest 
with a formula.

	 1.	 Enter =SORT(UNIQUE(B2:B564)) in cell K2. You will have a list of the unique 
region names spilling to K2:K5.

	 2.	 To get a list of unique products across the top of the report, enter =TRANSPOSE 
(SORT(UNIQUE(C2:C564))) in cell L1.

At this point, with 57 keystrokes, you’ve built the shell of the final report, but there are 
no numbers inside yet (see Figure I-1).

FIGURE I-1  It took 57 keystrokes to get to this point.

Next, you need to build a SUMIFS function to total the revenue for each Region and 
Product. As shown in Figure I-2, the formula =SUMIFS(G2:G564,B2:B564,K2#,C2:C56
4,L1#) does the trick. It takes 40 characters plus the Enter key to finish the formula.

FIGURE I-2  Before Dynamic Arrays were introduced, the formula in L2 would have needed dollar 
signs and then been copied to all 16 cells showing numbers.
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Enter the heading Total for the total row and for the total column. You can do this in 
nine keystrokes if you type the first heading, press Ctrl+Enter to stay in the same cell, and 
then use Copy, select the cell for the second heading, and use Paste.

If you select K1:P6 and press Alt+= (that is, Alt and the equal sign key), you can add 
the total formula in three keystrokes.

With this method, which takes 110 clicks or keystrokes, you end up with a nice sum-
mary report, as shown in Figure I-3. If you could pull this off in 5 or 10 minutes, you 
would probably be fairly proud of your Excel prowess; there are some good tricks among 
those 110 operations.

FIGURE I-3  A mere 110 operations later, you have a summary report.

You hand the report to your manager. Within a few minutes, they come back with one 
of the following requests, which will certainly cause a lot of rework:

■■ Could you put products down the side and regions across the top?

■■ Could you show me the same report for only the manufacturing customers?

■■ Could you show profit instead of revenue?

■■ Could you copy this report for each of the customers?

Invention of the pivot table

When the actual pivot table was invented is in dispute. The Excel team coined the term 
pivot table, which appeared in Excel in 1993. However, the concept was not new. Pito 
Salas and his team at Lotus were working on the pivot table concept in 1986 and released 
Lotus Improv in 1991. Before then, Javelin offered functionality similar to that of pivot 
tables.

The core concept behind a pivot table is that the data, formulas, and data views are 
stored separately. Each column has a name, and you can group and rearrange the data 
by dragging field names to various positions on the report.
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Case study: Life after pivot tables
Say that you’re tired of working so hard to remake reports every time your manager 
wants a change. You’re in luck: You can produce the same report as in the last case study 
but use a pivot table instead. Excel offers you 10 thumbnails of recommended pivot 
tables to get you close to the goal. Follow these steps:

	 1.	 Click the Insert tab of the ribbon.

	 2.	 Click Recommended PivotTables. Scroll through the list of suggested pivot 
tables, looking for one with Revenue, Product, and Region. You might have to 
click See All 10 Results below the fourth suggestion. As shown in Figure I-4, you 
could choose either Revenue By Region And Product or Revenue By Product 
And Region. Either one is fine. Choose the + Existing Sheet button beneath 
Revenue By Region And Product.

	 3.	 Excel will ask you to specify a starting cell for the pivot table. It is a good idea 
to leave a blank column to the right of your data and then have the pivot table 
start in cell K2. The initial pivot table will have both Region and Product in the 
first column of the pivot table. Your goal is to have the products appear along 
the top of the pivot table.

	 4.	 Drag the Product field from the Rows area to the Columns area (see Figure I-5).

FIGURE I-4  Choose a recommended pivot table that is as close as you will get to the desired report.
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FIGURE I-5  To finish the report, drag the Product heading to the Columns area.

With just a few clicks of the mouse, you have the report shown in Figure I-6.

FIGURE I-6  It took a few clicks to create this report.

In addition, when your manager comes back with a request like the ones near the end 
of the prior case study, you can easily use the pivot table to make the changes. Here’s a 
quick overview of the changes you’ll learn to make in the chapters that follow:

■■ Could you put products down the side and regions across the top? (This change 
will take you 10 seconds: Drag Product to Rows and Region to Columns.)

■■ Could you show me the same report for only the manufacturing customers? (15 
seconds: Select Insert Slicer | Sector. Then, click OK and click Manufacturing.)

■■ Could you show profit instead of revenue? (10 seconds: Clear the Revenue check-
box and select the Profit checkbox.)
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■■ Could you copy this report for each of the customers? (30 seconds: Move 
Customer to Report Filter, open the tiny dropdown next to the Options button, 
choose Show Report Filter Pages, and click OK. For more details, see Tip 17: Use a 
pivot table to explode a data set to different tabs in Chapter 14).

Creating a pivot table using Artificial Intelligence

The new Analyze Data tool uses artificial intelligence to analyze a data set. You can type 
a question in natural language, and Excel will create a pivot table.

With one cell in your data set selected, choose the Analyze Data command on the 
right side of the Home tab. The Analyze Data pane appears with several suggested 
analyses. In the Ask a Question box at the top, type Revenue by Product and Region as 
Table and press Enter.

Excel will draw a thumbnail of your report. Click +Insert PivotTable at the bottom of 
the thumbnail.

FIGURE I-7  Slightly more typing, but certainly easier to create.
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Who this book is for

This book is a comprehensive-enough reference for hard-core analysts yet relevant to 
casual users of Excel.

We assume that you are comfortable navigating in Excel and that you have some 
large data sets that you need to summarize.

How this book is organized

The bulk of the book covers how to use pivot tables in the Excel user interface. Chapter 
10, “Unlocking features with the Data Model and Power Pivot,” delves into the Power 
Pivot window. Chapter 13, “Using VBA or TypeScript to create pivot tables,” describes 
how to create pivot tables in Excel’s powerful VBA macro language. Chapter 18, “Using 
Artificial Intelligence and Copilot for Building Pivot Tables, describes using artificial 
intelligence and Copilot to create analyses. Anyone who has a firm grasp of basics such 
as preparing data, copying, pasting, and entering simple formulas should not have a 
problem understanding the concepts in this book.

About the companion content

The download files for this book include all of the data sets used to produce the book, so 
you can practice the concepts in the book. For access to these companion files, and other 
resources, visit MicrosoftPressStore.com/register, sign in or create a new account, and 
register ISBN 9780135408797 by December 31, 2027.

System requirements

You need the following software and hardware to build and run the code samples for 
this book:

You will need Microsoft Excel running on a Windows computer. (Yes, Excel runs on an 
iPad, on an Android tablet, but none of those are going to support the creation of pivot 
tables anytime soon.) For people using Excel on a Mac, some of the basic pivot table con-
cepts will apply. Power Query and Power Pivot will not run on a Mac. For people using 
Excel Online, you can make many of the pivot tables in this book, but you won’t be able 
to do as much formatting.
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Compact versus tabular layout

Microsoft changed the default layout of pivot tables in 2007 to something that it calls 
Compact layout. For various reasons that I will explain here, I am not a fan of Compact 
layout and have changed settings in Excel options so that my pivot tables are created in 
Tabular layout. As you work through this book, it will help if you can quickly recognize 
the contrast between how Compact and Tabular layouts show the same data.

In Figure I-8, columns N:Q show a traditional pivot table in tabular layout. Each of the 
three row fields appears in a different column with meaningful headings such as Region, 
Product, and Sector.

In contrast, columns S:T show the same data in compact layout. The meaningful head-
ings from N2:P2 are replaced by a single heading of “Row Labels” in S2. The values for 
Region, Product, and Sector are intermingled in column S with a different indent level 
showing if you are looking at a region, product name, or sector name.

FIGURE I-8  The Row Labels heading in S2 is the clue that your pivot tables are defaulting to  
Compact layout.

My irritation with the Compact layout is how Excel mixes Regions, Products, and  
Sectors in column S. Any human reading the report can tell the difference by noticing 
the indent levels. But there is no calculation function that can tell the difference between 
a field indented by eight spaces instead of four spaces. 

I know that in many cases, I will be converting the pivot table to values and using the 
static version of the table for other uses. Those other uses will always need each field in 
its own column.
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If you are following along with the examples in this book and end up with a pivot 
table in Compact layout, rest assured that the numbers in your pivot table and the num-
bers in the book are the same, just with different formatting. 

You can switch one pivot table to a new layout using the Design tab in the ribbon. 
Open the Report Layout dropdown and choose between Compact and Tabular.

If you happen to agree that the pivot table shown in columns N:Q of Figure I-8 is 
superior to the pivot table shown in columns S:T, then follow these steps to change your 
pivot table defaults on your computer.

	 1.	 Open the File menu and choose Excel Options.

	 2.	 In the Excel Options dialog, choose the Data category from the left navigation 
bar.

	 3.	 Click the top button for Edit Default Layout next to Make Changes To The 
Default Layout Of Pivot Tables.

	 4.	 Open the Report Layout dropdown and choose Show in Tabular Form.

	 5.	 Choose the box next to Repeat All Item Labels.

	 6.	 Click the PivotTable Options… button in the lower-right part of the Edit Default 
Layout dialog. There are five tabs across the top of the PivotTable Options 
dialog. 

	 7.	 On the Layout & Format tab, click in the For Empty Cells Show box and type a 
zero (0). Click OK three times to close all of the open dialogs.

Your pivot tables will now default to the format shown on the left side of Figure I.8.

Errata, updates, and book support

We’ve made every effort to ensure the accuracy of this book and its companion content. 
You can access updates to this book—in the form of a list of submitted errata and their 
related corrections—at the following page:

MicrosoftPressStore.com/Excel365pivotdata/errata

If you discover an error that is not already listed, please submit it to us at the same 
page.

For additional book support and information, please visit:

MicrosoftPressStore.com/Support
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Please note that product support for Microsoft software and hardware is not offered 
through the previous addresses. For help with Microsoft software or hardware, go to 
http://support.microsoft.com.

Stay in touch

Let’s keep the conversation going! We’re on X:

http://x.com/MicrosoftPress

http://x.com/MrExcel
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C H A P T E R  2

Creating a basic pivot table

In this chapter, you will:

■■ Format your source data before creating a pivot table

■■ Learn how to create a basic pivot table

■■ Understand the Recommended PivotTable and the Analyze Data features

■■ Use slicers to filter your report

■■ Keep up with changes in the data source

■■ Share the pivot cache

■■ Save time with PivotTable tools

When you have a family portrait taken, the photographer takes time to make sure that the lighting 
is right, the poses are natural, and everyone smiles their best smile. This preparation ensures that the 
resulting photo is effective in its purpose.

When you create a pivot table report, you’re the photographer, taking a snapshot of your data.  
By taking time to make sure your data looks its best, you can ensure that your pivot table report is 
effective in accomplishing the task at hand.

One of the benefits of working in a spreadsheet is that you have the flexibility of laying out your 
data to suit your needs. Indeed, the layout you choose depends heavily on the task at hand. However, 
many of the data layouts used for presentations are not appropriate when used as the source data for a 
pivot table report.

 

Tip  As you read the following pages, which discuss preparing your data, keep in mind that 
pivot tables have only one hard rule pertaining to the data source: The data source must 
have column headings, which are labels in the first row of the data that describe the infor-
mation in each column. Without column headings, you cannot create a pivot table report.

However, just because a pivot table report is created successfully does not mean that it’s effective.  
A host of things can go wrong as a result of bad data preparation—from inaccurate reporting to  
problems with grouping and sorting.
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Format your source data before creating a pivot table

Let’s look at a few of the steps you can take to ensure that you end up with a viable pivot table report.

Ensuring that data is in a Tabular layout
A perfect layout for the source data in a pivot table is a Tabular layout. In Tabular layout, there are no 
blank rows or columns. Every column has a heading. Every field has a value in every row in most cases. 
Columns do not contain repeating groups of data.

Figure 2-1 shows an example of data structured properly for a pivot table. There are headings for 
each column. Even though the values in D2:D6 are all the same model, the model number appears in 
each cell. Month data is organized down the page instead of across the columns.

FIGURE 2-1  This data is structured properly for use as a pivot table source.

Tabular layouts are database-centric, meaning you would most commonly find these types of  
layouts in databases. These layouts are designed to store and maintain large amounts of data in a  
well-structured, scalable format.

 

Tip  You might work for a manager who demands that the column labels be split into two 
rows. For example, they might want the heading Gross Margin to be split, with Gross in  
row 1 and Margin in row 2. Because pivot tables require a unique heading one row high, 
your manager’s preference can be problematic. To overcome this problem, start typing your 
heading; for example, type Gross. Before leaving the cell, press Alt+Enter and then type 
Margin. The result is a single cell that contains two lines of data.

Avoiding storing data in section headings
Examine the data in Figure 2-2. This spreadsheet shows a report of sales by month and a model for 
the North region of a company. Because the data in rows 2 through 24 pertains to the North region, 
the author of the worksheet entered the title North as a single cell in C1. This approach is effective for 
displaying the data, but it’s not effective for a pivot table data source.
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Also, in Figure 2-2, the author was very creative with the model information. The data in rows 2 
through 6 applies to Model 2500P, so the author entered this value once in A2 and then applied a fancy 
vertical format combined with Merge Cells to create an interesting look for the report. Again, although 
this is a cool format, it is not useful for pivot table reporting.

FIGURE 2-2  Region and model data are not formatted properly in this data set.

In addition, the worksheet in Figure 2-2 is missing column headings. You can guess that column A  
is Model, column B is Month, and column C is Sales. However, for Excel to create a pivot table, this 
information must be included in the first row of the data.

Avoiding repeating groups as columns
The format shown in Figure 2-3 is common. A time dimension is presented across several columns. 
Although it is possible to create a pivot table from this data, this format is not ideal.

FIGURE 2-3  This matrix format is common but not effective for pivot tables. The Month field is spread across  
several columns of the report.
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The problem is that the headings spread across the top of the table pull double duty as column 
labels and actual data values. In a pivot table, this format would force you to manage and maintain six 
fields, each representing a different month.

Eliminating gaps and blank cells in the data source
Delete all empty columns within your data source. An empty column in the middle of your data source 
causes your pivot table to fail on creation because the blank column, in most cases, does not have a 
column name.

Delete all empty rows within your data source. Empty rows may cause you to inadvertently leave out 
a large portion of your data range, making your pivot table report incomplete.

Fill in as many blank cells in your data source as possible. Although filling in cells is not required to 
create a workable pivot table, blank cells are generally errors waiting to happen. A good practice is to 
represent missing values with some logical missing value code wherever possible.

 

Note  Although eliminating gaps and blank cells might seem like a step backward for those 
of you who are trying to create a nicely formatted report, it pays off in the end. When you 
are able to create a pivot table, there will be plenty of opportunities to apply some pleasant 
formatting.

 

Note  In Chapter 3, “Customizing a pivot table,” you’ll discover how to apply style  
formatting to your pivot tables.

Applying appropriate type formatting to fields
Formatting fields appropriately helps you avoid a whole host of possible issues, from inaccurate  
reporting to problems with grouping and sorting.

Make certain that any fields to be used in calculations are explicitly formatted as a number, currency, 
or any other format appropriate for use in mathematical functions. Fields containing dates should also 
be formatted as any one of the available date formats.

Summary of good data source design
The attributes of an effective tabular design are as follows:

■■ The first row of your data source is made up of field labels or headings that describe the  
information in each column.

■■ Each column in your data source represents a unique category of data.
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■■ Each row in your data source represents individual items in each column.

■■ None of the column names in your data source double as data items that will be used as 
filters or query criteria (that is, names of months, dates, years, names of locations, or names of 
employees).

 

Case study: Cleaning up data for pivot table analysis

The worksheet shown in Figure 2-4 is a great-looking report. However, it cannot be  
effectively used as a data source for a pivot table. Can you identify the problems with this 
data set?

FIGURE 2-4  Someone spent a lot of time formatting this report to look good, but what problems prevent it 
from being used as a data source for a pivot table?

These are the three problems with the data set and the fixes needed to get the data set 
pivot table ready:

■■ There are blank rows and columns in the data. Column C should be deleted. The blank 
rows between sectors (such as rows 4, 11, and 15) also should be deleted.

■■ Blank cells present the data in an outline format. The person reading this worksheet 
would probably assume that cells A6:A10 fall into the Consultants sector. These blank 
cells need to be filled in with the values from above.

■■ The worksheet presents the data for each month in several columns (one column per 
month). Columns D through O need to be reformatted as two columns. Place the 
month name in one column and the units for that month in the next column.
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Cleaning this data used to require some VBA code or a bunch of manual steps in Excel.  
The Get & Transform tools that debuted in Excel 2016 will make it very easy to clean this data. 
Follow these steps:

	 1.	 Select the entire range of data. In the sample file, it would be A1:O33.

	2.	 Click in the Name box and type a one-word name, such as UglyData. Press Enter to name  
the range.

	3.	 On the Data tab, in the Get & Transform Data group, choose From Table/Range (see  
Figure 2-5).

FIGURE 2-5  Originally called Power Query but later rebranded as Get & Transform Data, these new tools that 
appeared on the Data tab in 2016 are amazing.

The Power Query Editor will open. Notice you have ribbon tabs for Home, Transform, Add 
Column, and View. Follow these steps in the Power Query Editor.

	4.	 The formerly blank column C now has a heading of Column 3. Click that heading and 
choose Remove Columns from the Home tab (see Figure 2-6).

FIGURE 2-6  The Power Query Editor offers tools that are often better than their Excel equivalents.
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	 5.	 Click the Customer heading. Choose Home | Remove Rows | Remove Blank Rows (see  
Figure 2-7).

FIGURE 2-7  Deleting blank rows is a built-in command in Power Query.

	6.	 Select the Sector column header. From the Transform tab, choose Fill | Down (see  
Figure 2-8). This amazing command will replace all the null cells with the value from 
above.

FIGURE 2-8  Fill Down replaces Home | Find & Select | Go To Special | Blanks | OK, and then entering =A2 and  
pressing Ctrl+Enter. It is far easier to remember one command instead of many obscure commands strung 
together.

	 7.	 Select both the Sector and Customer headings. 

	8.	 Open the Unpivot Columns dropdown on the Transform tab and choose Unpivot Other  
Columns. The result is shown in Figure 2-9. Pause for a moment to admire the sheer  
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simplicity of steps 5 through 8. Those are three new tools that replace far more  
complicated tasks in Excel. Although the data could be returned to Excel at this point, 
there are a few simple clean-up steps left.

FIGURE 2-9  At this point, you could return the data to Excel for pivoting.

	 9.	 Right-click the Value column. Choose Rename and type Revenue.

	10.	 Open the Filter dropdown for Revenue. Unselect 0 to remove all the zero values.

	11.	 Select the Attribute Column. On the Add Column tab, choose Column From Example. The 
first row in your data might read “Apr.” If this data applies to the year 2029, type a value 
of Apr 1, 2029 in the new column. Power Query fills in the remaining rows and offers a 
Merged heading. Click OK (see Figure 2-10).

FIGURE 2-10  Add Column From Example is similar to Flash Fill in Excel, but it actually creates a formula that can  
be reused.

	12.	 Right-click the heading for the new Merged column. Choose Rename and type Date as 
the heading name.
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	13.	 With the Date column selected, click the Transform tab. Open the Date Type dropdown 
and choose Date. The text dates are converted to real dates.

	14.	 You no longer need the month abbreviations shown in the Attribute column. Choose the 
Attribute column and then Home | Remove Columns. Before you return to Excel, look at 
the right side of the Power Query window for the list of Applied Steps. This is the world’s 
greatest Undo stack. You can click any step and see what the data looked like at that 
point. If you made a mistake several steps ago, you can click that step and make a correc-
tion. If you want to be more impressed, select the View tab and choose Advanced Editor. 
All that code is a programming language called “M.” By doing steps 4 through 13, you 
successfully wrote a program that can be reused the next time you download similar data 
from the IT department.

	15.	 Select Home | Close | Load. Your original data stays on Sheet1, and a new Sheet2 is added 
to the workbook (see Figure 2-11). The cleaned data is narrow and tall. In general, narrow 
and tall data sets are better for pivoting.

FIGURE 2-11  Just 11 steps in Power Query quickly cleaned the ugly data.

		  Not only is Power Query fast, it makes it easy to redo the data cleansing. Go back to Sheet1 
and change any number in the original data. Go to Sheet2. Expand the Queries & Connections 
panel so you can click the Refresh icon on the far right of the UglyData query. Power Query 
repeats all the steps and updates the result.

How to create a basic pivot table

Now that you have a good understanding of the importance of a well-structured data source, let’s walk 
through creating a basic pivot table.

 

Note  The sample data set used throughout this book is available for download at  
www.microsoftpressstore.com/ExcelPivotTable/downloads.
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To ensure that the pivot table captures the range of your data source by default, click any single cell 
in your data source. Next, select the Insert tab and find the Tables group. In the Tables group, select 
PivotTable and then choose From Table/Range from the dropdown. Figure 2-12 demonstrates how to 
start a pivot table.

FIGURE 2-12  Start a pivot table by selecting PivotTable from the Insert tab.

Choosing these options activates the Create PivotTable dialog, shown in Figure 2-13.

FIGURE 2-13  The Create PivotTable dialog.

 

Tip  You can also press the shortcut to start a pivot table: Press and release Alt, press and 
release N, and then press and release V.

As you can see in Figure 2-13, the Create PivotTable dialog asks you only two fundamental questions:

■■ Where’s the data that you want to analyze?

■■ Where do you want to put the pivot table?

Here’s how you handle these two sections of the dialog:

■■ Choose The Data That You Want To Analyze—In this section, you tell Excel where your data 
set is. You can specify a data set that is located within your workbook, or you can tell Excel to 
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look for an external data set. As you can see in Figure 2-13, Excel is smart enough to read your 
data set and fill in the range for you. However, you should always take note of the range Excel 
selects to ensure that you are capturing all your data.

■■ Choose Where You Want The PivotTable Report To Be Placed—In this section, you tell Excel 
where you want your pivot table to be placed. This is set to New Worksheet by default, meaning 
that your pivot table will be placed in a new worksheet within the current workbook. You will 
rarely change this setting because there are relatively few times you’ll need your pivot table to 
be placed in a specific location.

 

Note  Note the presence of another option in the Create PivotTable dialog shown in  
Figure 2-13: the Add This Data To The Data Model option. You would select this option if you 
were trying to consolidate multiple data sources into a single pivot table.

The Add This Data To The Data Model option is covered in detail in Chapter 7,  
“Analyzing disparate data sources with pivot tables,” and in Chapter 10, “Unlocking  
features with the Data Model and Power Pivot.”

In this chapter, we’ll keep it basic by covering the steps to create a pivot table by using 
a single source, which means you can ignore this particular option.

After you have answered the two questions in the Create PivotTable dialog, simply click the OK  
button. At this point, Excel adds a new worksheet that contains an empty pivot table report. Next to 
that is the PivotTable Fields list, shown in Figure 2-14. This pane helps you build your pivot table.

FIGURE 2-14  You use the PivotTable Fields list to build a pivot table.
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Caution  The icons for Columns and Rows in Figure 2-14 are reversed. A summer intern at 
Microsoft inadvertently reversed the icons several versions ago, and no one noticed. After 
Bill pointed this out to the correct project manager, Microsoft pledged to restore the icons 
to the correct location. The dark-gray portion of the icon is supposed to show where the 
data will be displayed when you drop a field here. Any data dropped into the Columns area 
will display across the top of the report (as illustrated in the icon currently in the Rows area). 
It feels sort of goofy to show the wrong icons in this book on pivot tables, but that’s the way 
it appears to us at press time.

 

Tip  Finding the PivotTable Fields list

The PivotTable Fields list is your main work area in Excel. This is the place where you add 
fields and make changes to a pivot table report. By default, this pane pops up when you 
place your cursor anywhere inside a pivot table. However, if you explicitly close this pane, 
you override the default and essentially tell the pane not to activate when you are in the 
pivot table.

If clicking on the pivot table does not activate the PivotTable Fields list, you can manually 
activate it by right-clicking anywhere inside the pivot table and selecting Show Field list. You 
can also click anywhere inside the pivot table and then choose the large Fields List icon on 
the Analyze tab under PivotTable Tools in the ribbon.

Adding fields to a report
You can add the fields you need to a pivot table by using the four “areas” found in the PivotTable Fields 
list: Filters, Columns, Rows, and Values. These areas, which correspond to the four areas of the pivot 
table, are used to populate your pivot table with data: 

■■ Filters—Adding a field to the Filters area enables you to filter on its unique data items.  
In previous versions of Excel, this area was known as the Report Filters area.

■■ Columns—Adding a field into the Columns area displays the unique values from that field 
across the top of the pivot table.

■■ Rows—Adding a field into the Rows area displays the unique values from that field down the 
left side of the pivot table.

■■ Values—Adding a field into the Values area includes that field in the Values area of your pivot 
table, allowing you to perform a specified calculation using the values in the field.

Note  Review Chapter 1, “Pivot table fundamentals,” for a refresher on the four areas of a 
pivot table.
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Fundamentals of laying out a pivot table report
Now, let’s pause a moment and go over some fundamentals of laying out a pivot table report. This is 
generally the point where most new Excel customers get stuck. How do you know which field goes 
where?

Before you start dropping fields into the various areas, answer two questions:

■■ “What am I measuring?”

■■ “How do I want to see it?”

The answer to the first question tells you which fields in your data source you need to work with, and 
the answer to the second question tells you where to place the fields.

Let’s say you wanted to measure the dollar sales by region. This would automatically tell you that 
you need to work with the Sale Amount and Region fields. How do you want to see it? You want regions 
to go down the left side of the report and the sales amount to be calculated next to each region.

To achieve this effect, you need to add the Region field to the Rows area and add the Sale Amount 
field to the Values area.

Find the Region field in the PivotTable Fields list and select the checkbox next to it. As you can see 
in Figure 2-15, not only is the field automatically added to the Rows area, but also your pivot table is 
updated to show the unique region names.

FIGURE 2-15  Select the checkbox next to the Region field to automatically add that field to your pivot table.
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Tip  If you see a region that is repeated in the Rows area, it usually means that there are 
one or more trailing spaces after some of the rows for that region. You should find those 
cells, delete the trailing spaces, and then Refresh the pivot table.

Now that you have regions in your pivot table, it’s time to add in the dollar sales. To do that, simply 
find the Sale Amount field and select the checkbox next to it. As Figure 2-16 shows, the Sale Amount 
field is automatically added to the Values area, and your pivot table report now shows the total dollar 
sales for each region.

FIGURE 2-16  Select the checkbox next to the Sale Amount field to add data to your pivot table report.

At this point, you have already created your first pivot table report!

 

Tip  How does Excel know where your fields go?

As you’ve just experienced, the PivotTable Fields list interface enables you to add fields to 
your pivot table by simply selecting the checkbox next to each field name. Excel automati-
cally adds the selected fields to the pivot table. But how does Excel know which area to use 
for a field you select? The answer is that Excel doesn’t really know which area to use, but it 
makes a decision based on data type. Here’s how it works: When you select a checkbox next 
to a field, Excel evaluates the data type for that field. If the data type is numeric, Excel places 
the field in the Values area; otherwise, Excel places the field in the Rows area. This placement 
obviously underlines the importance of correctly assigning the data types for your fields.
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Note  Blank cells in your numeric columns previously caused the column to be treated as 
text. A change in early 2018 for Office 365 subscribers changed this behavior. Now, a column 
with a mix of numbers and empty cells will be treated as values, and the field will go to the 
Values area with a default calculation of Sum.

If you have someone who clears out cells by mashing down the spacebar several times 
instead of using the Delete key, Excel will treat those spaces as text. A mix of numbers and 
text in a column will cause Excel to default to counting the column instead of summing.

Adding layers to a pivot table
Now, you can add another layer of analysis to your report. Say that now you want to measure the 
amount of dollar sales each region earned by product category. Because your pivot table already  
contains the Region and Sales Amount fields, all you have to do is select the checkbox next to the  
Product Category field. As you can see in Figure 2-17, your pivot table automatically added a layer for 
the Product Category and refreshed the calculations to include subtotals for each region. Because the 
data is stored efficiently in the pivot cache, this change took less than a second.

FIGURE 2-17  Without pivot tables, adding layers to analyses requires hours of work and complex formulas.

Rearranging a pivot table
Suppose that the view you’ve created doesn’t work for your manager. He wants to see Product  
Categories across the top of the pivot table report. To make this change, simply drag the Product  
Category field from the Rows area to the Columns area, as illustrated in Figure 2-18.
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Note  You don’t have to move your fields into an area to be able to drag them around. 
You can actually drag fields directly from the list of fields in the PivotTable Fields list to the 
desired area. You can also move a field into an area by using that field’s context menu:  
Click the black triangle next to the field name and then select the desired area.

FIGURE 2-18  Rearranging a pivot table is as simple as dragging fields from one area to another.

The report is instantly restructured, as shown in Figure 2-19.

FIGURE 2-19  Your product categories are now column-oriented.
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Tip  Longing for drag-and-drop functionality?

In Excel 2003 and previous versions, you could drag and drop fields directly onto the pivot 
table layout. This functionality is allowed only within the PivotTable Fields list (dragging into 
areas). However, Microsoft has provided the option of working with a classic pivot table  
layout, which enables drag-and-drop functionality.

To activate the classic pivot table layout, right-click anywhere inside the pivot table and 
select PivotTable Options. In the PivotTable Options dialog, select the Display tab and select 
the checkbox next to Classic PivotTable Layout, as demonstrated in Figure 2-20. Click the OK 
button to apply the change.

FIGURE 2-20  Select the checkbox next to Classic PivotTable Layout.

At this point, you can drag and drop fields directly onto your pivot table layout. If you 
always want your pivot tables to be in Classic layout, follow these steps:

1.	  Select File | Options. A new Data category is added along the left panel starting in 2017 
for Microsoft 365 subscribers.

2.	 In the Data category, the first setting is Make Changes To The Default Layout Of Pivot-
Tables. Click Edit Default Layout.

3.	The Edit Default Layout dialog offers a few common choices. Apparently, Classic layout 
did not make it to the top few choices. Click the PivotTable Options button in the Edit 
Default Layout dialog. You will see a dialog similar to Figure 2-20. Choose the Display 
tab and the Classic PivotTable Layout. Click OK three times to close each of the open 
dialogs. All future pivot tables can be built in Classic mode.
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Creating a report filter
You might be asked to produce different reports for particular regions, markets, or products.  
Instead of building separate pivot table reports for every possible analysis scenario, you can use the 
Filter field to create a report filter. For example, you can create a region-filtered report by simply  
dragging the Region field to the Filters area and the Product Category field to the Rows area. This  
way, you can analyze one particular region at a time. Figure 2-21 shows the totals for just the North 
region.

FIGURE 2-21  With this setup, you not only can see revenues by product clearly, but also can click the Region  
dropdown to focus on one region.

Understanding the Analyze Data, Copilot, and Recommended 
PivotTable features

As this book is being written in the summer of 2024, the Artificial Intelligence industry is moving at the 
speed of sound. At this point, Copilot is still in preview and will be coming out to General Availability 
later in 2024.

At this moment, the Analyze Data feature is the mature option for creating pivot tables and pivot 
charts using Artificial Intelligence. In 2024, Microsoft changed the legacy Recommended PivotTable 
functionality to use the same algorithm as the Analyze Data. Looking forward, the ability for Copilot to 
create a pivot table has been trained using the existing Analyze Data feature.
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Tip  Analyze Data feature uses artificial intelligence

The Analyze Data feature uses artificial intelligence to analyze up to 250,000 cells of your 
data. It offers descriptive pivot tables and then offers far more advanced analyses. The  
Analyze Data feature often produces over 30 choices. Figures 2-22 and 2-23 show some 
results available from it.

FIGURE 2-22  Artificial Intelligence detected a pair of outliers in this segment of the data.

FIGURE 2-23  Ideas detected a repeating pattern. This might indicate some weekly or monthly seasonality.

Unfortunately, customers who purchased a perpetual license to Excel 2021 or Excel 2024 
will not have the feature in either location. Microsoft’s stance is that if you are not continu-
ing to pay a monthly subscription fee, you cannot make use of the Office intelligent services.

In late 2019, a second iteration of artificial intelligence was added that allows you to ask a 
natural-language question about your data. See Figure 7 in the Introduction for an example.
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Using slicers to filter your report

With Excel 2010, Microsoft introduced a feature called slicers. Slicers enable you to filter your pivot 
table in much the same way as Filter fields filter a pivot table. The difference is that slicers offer a  
user-friendly interface that enables you to easily see the current filter state, even when multiple items 
are selected.

Creating a standard slicer
To understand the concept behind slicers, place your cursor anywhere inside your pivot table and then 
select the Insert tab on the ribbon. Click the Slicer icon (see Figure 2-24).

FIGURE 2-24  Inserting a slicer.

The Insert Slicers dialog, shown in Figure 2-25, opens. The idea is to select the dimensions you want 
to filter. In this example, the Region and Market slicers are selected.

FIGURE 2-25  Select the dimensions for which you want to create slicers.

After the slicers are created, you can simply click the filter values to filter your pivot table. As you 
can see in Figure 2-26, clicking Midwest in the Region slicer filters your pivot table, and also the Market 
slicer responds by highlighting the markets that belong to the Midwest region.
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FIGURE 2-26  Select the dimensions you want to filter using slicers.

 

Tip  You can select multiple values by holding down the Ctrl key on your keyboard while 
selecting the needed filters. Alternatively, you can enable the Multi-Select toggle next to the 
filter icon at the top of the slicer.

In Figure 2-27, the Multi-Select toggle was enabled and then Baltimore, California, Charlotte, and 
Chicago were selected. Note that Excel highlights the selected markets in the Market slicer and also 
highlights their associated regions in the Region slicer.

Another advantage you gain with slicers is that you can tie each slicer to more than one pivot table. 
In other words, any filter you apply to your slicer can be applied to multiple pivot tables.

To connect a slicer to more than one pivot table, simply right-click the slicer and select Report  
Connections. The Report Connections dialog, shown in Figure 2-28, opens. Select the checkbox next to 
any pivot table that you want to filter using the current slicer.

At this point, any filter applied via the slicer is applied to all the connected pivot tables. Again,  
slicers have a unique advantage over Filter fields in that they can control the filter state of multiple 
pivot tables. Filter fields can control only the pivot table in which they live.

Note that the choices in Figure 2-28 are the pivot tables that rely on the same pivot table cache. 
If you want to use a slicer to control data coming from two different data sets, see “Tip 22 – Slicer to 
control data from two different data sets” in Chapter 14.
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The Multi-Select Toggle

FIGURE 2-27  The fact that they enable you to see the current filter state gives slicers a unique advantage over the 
Filter field.

FIGURE 2-28  Choose the pivot tables you want to filter using this slicer.

 

Tip  Notice that in Figure 2-28, the list of pivot tables is a bit ambiguous (PivotTable1, Piv-
otTable2). Excel automatically gives your pivot tables these generic names, which it uses to 
identify them. You can imagine how difficult it would be to know which pivot table is which 
when working with more than a handful of pivots. Therefore, you might want to consider 
giving your pivot tables user-friendly names so you can recognize them in dialogs, such as 
the one you see in Figure 2-28.

You can easily change the name of a pivot table by placing your cursor anywhere inside 
the pivot table, selecting the PivotTable Analyze tab, and entering a friendly name in the 
PivotTable Name input box found on the far left.
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Creating a Timeline slicer
The Timeline slicer (introduced with Excel 2013) works in the same way as a standard slicer in that it lets 
you filter a pivot table using a visual selection mechanism instead of the old Filter fields. The difference 
is that the Timeline slicer is designed to work exclusively with date fields, and it provides an excellent 
visual method to filter and group the dates in a pivot table.

 

Note  In order to create a Timeline slicer, your pivot table must contain a field where all the 
data is formatted as dates. This means that your source data table must contain at least one 
column where all the values are formatted as valid dates. If even only one value in the source 
date column is blank or not a valid date, Excel does not create a Timeline slicer.

To create a Timeline slicer, place your cursor anywhere inside your pivot table, select the Insert tab 
on the ribbon, and then click the Timeline icon.

The Insert Timelines dialog opens, showing you all the available date fields in the chosen pivot table. 
Here, you select the date fields for which you want to create slicers.

After your Timeline slicer is created, you can filter the data in your pivot table by using this dynamic 
data-selection mechanism. As you can see in Figure 2-29, clicking the April slicer filters the data in the 
pivot table to show only April data.

FIGURE 2-29  Click a date selection to filter your pivot table.

Figure 2-30 demonstrates how you can expand the slicer range with the mouse to include a wider 
range of dates in your filtered numbers.

FIGURE 2-30  You can expand the range on the Timeline slicer to include more data in the filtered numbers.
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Want to quickly filter your pivot table by quarters? Well, you can easily do it with a Timeline slicer. 
Click the time period dropdown and select Quarters. As you can see in Figure 2-31, you also can select 
Years, Months, or Days, if needed.

FIGURE 2-31  Quickly switch between filtering by years, quarters, months, and days.

 
Note  Be aware that Timeline slicers are not backward compatible with Excel 2010 or earlier.

 

Case study: Analyzing activity by market

Your organization has 18 markets that sell 7 types of products. You have been asked to build 
a report that breaks out each market and highlights the dollar sales for each product. You 
are starting with an intimidating transaction table that contains more than 91,000 rows of 
data. To start your report, do the following:

1.	 Place your cursor inside the data set, select the Insert tab, and click PivotTable.

2.	 When the Create PivotTable dialog appears, click the OK button. At this point, you 
should see an empty pivot table with the PivotTable Fields list.

3.	 Find the Market field in the PivotTable Fields list and select the checkbox next to it.

4.	 Find the Sale Amount field in the PivotTable Fields list and select the checkbox next to it.

5.	 To get the product breakouts, find the Product Category field in the PivotTable Fields list 
and drag it into the Columns area.

In five easy steps, you have calculated and designed a report that satisfies the requirements. 
After a little formatting, your pivot table report should look similar to the one shown in  
Figure 2-32.

Lest you lose sight of the analytical power you just harnessed, keep in mind that your data 
source has more than 91,000 rows and 14 columns, which is a hefty set of data by Excel stan-
dards. Despite the amount of data, you produced a relatively robust analysis in a matter of 
minutes.

For review purposes only. Do not distribute. Copyright Pearson Eduction. All rights reserved. 



	 Chapter 2  Creating a basic pivot table	 35

FIGURE 2-32  This summary can be created in less than a minute.

Keeping up with changes in the data source

Let’s go back to the family portrait analogy. As years go by, your family will change in appearance and 
might even grow to include some new members. The family portrait that was taken years ago remains 
static and no longer represents the family today. So, another portrait needs to be taken.

As time goes by, your data might change and grow with newly added rows and columns. However, 
the pivot cache that feeds your pivot table report is disconnected from your data source, so it cannot 
represent any of the changes you make to your data source until you take another snapshot.

The action of updating your pivot cache by taking another snapshot of your data source is called 
refreshing your data. There are two reasons you might have to refresh your pivot table report:

■■ Changes have been made to your existing data source.

■■ Your data source’s range has been expanded with the addition of rows or columns.

The following sections explain how to keep your pivot table synchronized with the changes in your 
data source.

Dealing with changes made to the existing data source
If a few cells in your pivot table’s source data have changed due to edits or updates, you can refresh 
your pivot table report with a few clicks. Simply right-click inside your pivot table report and select 
Refresh. This selection takes another snapshot of your data set, overwriting your previous pivot cache 
with the latest data.

 

Note  You can also refresh the data in a pivot table by selecting the Refresh icon on the  
PivotTable Analyze tab or Refresh All on the Data tab.
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Tip  Clicking anywhere inside a pivot table activates the PivotTable tabs in the ribbon.

Dealing with an expanded data source range due to the addition 
of rows or columns
When changes have been made to your data source that affect its range (for example, if you’ve added 
rows or columns), you have to update the range being captured by the pivot cache.

To do this, click anywhere inside the pivot table and then select the PivotTable Analyze tab in the 
ribbon. From here, select Change Data Source. This selection triggers the dialog shown in Figure 2-33.

FIGURE 2-33  The Change PivotTable Data Source dialog enables you to redefine the source data for your pivot table.

All you have to do here is update the range to include new rows and columns. After you have  
specified the appropriate range, click the OK button.

Note that if you format your pivot table source data as a table by choosing  Home | Format As Table; 
Insert | Table; or pressing Ctrl+T, the Pivot Table Source range will automatically expand as the data 
grows. You will still have to click Refresh to pick up the new rows.

Sharing the pivot cache or creating a new cache

You quite often need to analyze the same data set in multiple ways. In most cases, this process requires 
you to create separate pivot tables from the same data source. Keep in mind that every time you create 
a pivot table, you are storing a snapshot of the entire data set in a pivot cache. Every pivot cache that 
is created increases your memory usage and file size. For this reason, you should consider sharing your 
pivot cache.

 

Note  In situations where you need to create multiple pivot tables from the same data 
source, you can use the same pivot cache to feed multiple pivot tables. By using the same 
pivot cache for multiple pivot tables, you gain a certain level of efficiency when it comes to 
memory usage and file size.
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In legacy versions of Excel, when you created a pivot table using a data set that was already being 
used in another pivot table, Excel actually gave you the option of using the same pivot cache. However, 
Excel today does not give you such an option.

Instead, each time you create a new pivot table in Excel, Excel automatically shares the pivot cache. 
Most of the time, this is beneficial: You can link as many pivot tables as you want to the same pivot 
cache with a negligible increase in memory and file size.

On the flip side, when you group one pivot table by month and year, all the pivot tables are grouped 
similarly. If you want one pivot table by month and another pivot table by week, you have to force a 
separate pivot cache. You can force Excel to create a separate pivot cache by taking the following steps:

	 1.	 Select one cell in your original data set.

	 2.	 Press and release Alt+D, and then press P to launch the PivotTable Wizard.

	 3.	 Click the Next button to get past the first screen of the wizard.

	 4.	 On the second screen, select the range for your pivot table and click the Next button.

	 5.	 Excel displays a wordy message saying that you can use less memory if you click Yes. Instead, 
click No.

	 6.	 On the next screen, click the Finish button.

At this point, you have a blank pivot table that pulls from its own pivot cache.

 

Tip  If you already have an existing pivot table, you can use an alternative method for  
creating a separate pivot cache: Copy and paste the existing table to a new workbook and 
then copy and paste the pivot table back to a new sheet in the original workbook.

Side effects of sharing a pivot cache
It’s important to note that there are a few side effects to sharing a pivot cache. For example, suppose 
you have two pivot tables using the same pivot cache. Certain actions affect both pivot tables, each of 
which is discussed further in Chapter 5, “Performing calculations in pivot tables”:

■■ Refreshing your data—You cannot refresh one pivot table and not the other. Refreshing 
affects both tables.

■■ Adding a calculated field—If you create a calculated field in one pivot table, your newly  
created calculated field shows up in the PivotTable Fields list of the other pivot table.

■■ Adding a calculated item—If you create a calculated item in one pivot table, it shows in the 
other as well.
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■■ Grouping or ungrouping fields—Any grouping or ungrouping you perform affects both 
pivot tables. For instance, suppose you group a date field in one pivot table to show months. 
The same date field in the other pivot table is also grouped to show months.

Although none of these side effects are critical flaws in the concept of sharing a pivot cache, it is 
important to keep them in mind when determining whether using a pivot table as your data source is 
the best option for your situation.

Saving time with PivotTable tools

Microsoft has invested a lot of time and effort in the overall pivot table experience. The results of these 
efforts are tools that make pivot table functionality more accessible and easier to use. The following 
sections look at a few of the tools that help you save time when managing pivot tables.

Deferring layout updates
The frustrating part of building a pivot table from a large data source is that each time you add a field 
to a pivot area, you are left waiting while Excel crunches through all that data. This can become a mad-
deningly time-consuming process if you have to add several fields to your pivot table.

Excel offers some relief for this problem by providing a way to defer layout changes until you are 
ready to apply them. You can activate this option by selecting the relatively inconspicuous Defer Lay-
out Update checkbox in the PivotTable Fields list, as shown in Figure 2-34.

Here’s how this feature works: With the Defer Layout Update checkbox selected, you prevent your 
pivot table from making real-time updates as you move your fields around without your pivot table. 
When you are ready to apply your changes, click the Update button on the lower-right corner of the 
PivotTable Fields list.

FIGURE 2-34  Select the Defer Layout Update checkbox to prevent your pivot table from updating while you add fields.
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Note  Remember to clear the checkmark from the Defer Layout Update checkbox when 
you are done building your pivot table. Leaving it selected results in your pivot table  
remaining in a state of manual updates, preventing you from using other features of the 
pivot table, such as sorting, filtering, and grouping.

 

Tip  Incidentally, the Defer Layout Update option is available through VBA. It can help 
improve the performance of any macro that automates the creation of pivot tables.

 

Note  For detailed information on how to use VBA to create pivot tables, refer to  
Chapter 13, “Using VBA or TypeScript to create pivot tables.”

Starting over with one click
Often, you might want to start from scratch when working with your pivot table layouts. Excel provides 
a simple way to essentially start over without deleting your pivot cache. Select the PivotTable Analyze 
tab and select the Clear dropdown. As you can see in Figure 2-35, this command enables you to either 
clear your entire pivot table layout or remove any existing filters you might have applied in your pivot 
table.

FIGURE 2-35  The Clear command enables you to clear your pivot table fields or remove the applied filters from 
your pivot table.

Relocating a pivot table
You might find that after you have created a pivot table, you need to move it to another location. 
It might be in the way of other analyses on the worksheet, or you might simply need to move it to 
another worksheet. Although there are several ways to move a pivot table, the easiest is Excel’s no-frills 
way: Select Move PivotTable from the PivotTable Analyze tab in the ribbon. This icon activates the 
Move PivotTable dialog, shown in Figure 2-36. All you have to do here is specify where you want your 
pivot table moved.

For review purposes only. Do not distribute. Copyright Pearson Eduction. All rights reserved. 



40	 Chapter 2  Creating a basic pivot table

FIGURE 2-36  The Move PivotTable dialog enables you to quickly move your pivot table to another location.

Show Details for any cell in the values area
You’ve produced a pivot table and sent it to your manager, who takes one look at it and says, “This can’t 
be right! There is no way we sold $205K of Concession Equipment to Canada!”

Any time someone questions one of the numbers in the values area of your pivot table, simply select 
the cell containing the value. On the PivotTable Tools tab, click Show Details (see Figure 2-37).

FIGURE 2-37  Click any number in the Values area and then click Show Details.

Excel will insert a new sheet to the left of the current sheet. This sheet will contain a title indicating 
what cell was active when Show Details was clicked. There will be a blank row 2 and then all of the rows 
from the original data set that make up the selected number, as shown in Figure 2-38.

Before 2024, you could achieve this Show Details report by double-clicking any cell in the pivot 
table Values area. In 2024, Microsoft added the Show Details button to the ribbon and improved the 
result by adding the title.
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FIGURE 2-38  Excel inserts a new worksheet to the left of the active sheet with all of the rows that make up the 
selected number.

If you use Show Details on the total number at the intersection of the Grand Total row and the 
Grand Total column, the Show Details report will be an exact copy of the entire original data set.

You can use Show Details over and over. Each time will create a new worksheet to the left of the 
active sheet. If you don’t need these worksheets, you can press Ctrl+Z to undo; Excel will remove the 
new sheet.

Next steps

In Chapter 3, you’ll learn how to enhance your pivot table reports by customizing your fields,  
changing field names, changing summary calculations, applying formats to data fields, adding and 
removing subtotals, and using the Show As setting.
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Index

Symbols and Numerics
3D Map, 291

animating data over time, 300
building a column chart, 294–295
building a tour, 300–301
building pie or bubble charts on a map, 296–297
creating a video, 301–302
data card, 299
Effect dropdown, 301
fine-tuning, 299
Funnel icon, 299
geocoding data, 292–293
heat maps, 297–298
labeling individual points, 296
layers, 294
navigating through the map, 294–296
preparing data, 292
region maps, 297–298
scenes, 300–301
settings, 298
time scrubber, 300
up and down arrow icons, 296
using a store map, 302–304
zooming in and out, 294–295

18-CocaColaFinancialStatements.xlsx, 529
32-bit Excel, 285

A
AddFields method, 336–337
Advanced Editor, Power Query, 197
adverbs, 331
AI (artificial intelligence), 28. See also Analyze Data; Chat-

GPT;  
Copilot; prompt
Analyze Data feature, 28–29, 463
bots, 532
hallucination, 498
LLMs (large language models), 491
summarizing Excel YouTube videos, 532–534

Alexander, Mike, 437
Allington, Matt, Supercharge Power BI 3rd Edition, 287
Analysis icon, 214

Analyze Data, 497
artificial intelligence, 28–29, 463
asking questions, 503–506
versus Copilot, 498, 512
icon, 497
pane, 498–500
suggested analyses, 500–502

animating data over time, 300
Append query, 430–433
applied steps, Power Query, 195–197
Areas section, dropdowns, 81
Ask a Question, 503, 530
Assign Macro dialog, 312
autofilter, 409–411
AutoShow method, 369–371
AutoSort method, 351

B
backwards compatibility, pivot table, 7. See also Check 

Compatibility tool
bar chart, 214–215
big data, processing with Power Query, 271–273
blank cells, 15, 24

filling, 401
 in the data area, 340
 Repeat All Item Labels feature, 402
 in the row area, 341
 using Go To Special, 403–404

removing, 14, 350–351
replacing with zeros, 47–48

blank lines, adding, 55–56
border, applying to a pivot table, 62–63
bots, 532
Browse dialog, 461
bubble chart, building, 296–297
bug

count of revenue, 63
filter update, 97

building your first Data Model,  
178–181

built-in themes, 61
button/s

macro, 316
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button/s

pivot field, 155–156, 165
Show Report Filter Pages, 419
Test MDX, 246

C
CALCULATE, 282–283
calculated columns, adding in the Power Pivot  

grid, 279
calculated field/s, 123, 124

constants, 141
creating, 127–130, 132–135

 manually adding to the data source, 124–125
 using a formula, 125–126

editing and deleting, 148–149
functions, 139, 141
inserting directly into a pivot table, 126–127
managing, 148
measure, 123
named ranges, 141
order of operator precedence, 140–141
referencing totals, 141
rules specific to, 141–143
VBA, 362–363

calculated item/s, 123–124
changing the solve order, 149–150
constants, 141
creating, 135–139
functions, 139, 141
GetPivotData problem, 442–445. See also GetPivot-

Data
named ranges, 141
order of operator precedence, 140–141
referencing totals, 141
rules specific to, 148
VBA, 363–365

calculated measures, creating, 244–247
calculated members, 243, 247–250
calculations, 342–343. See also formula/s; function/s

Distinct Count, 264–266
grand totals, customizing, 56–57
median, creating in a pivot table using DAX measures, 

268–270
percentage, tracking, 70
percentage change, 426–428
rank options, 68
running total, 68–69
specifying in VBA, 360–362
subtotals

 adding and removing, 71
 adding multiple for one field, 72–73
 suppressing, 71–72

Sum of Revenue, renaming to Revenue, 49
summary

 adding and removing subtotals, 71

 adding multiple subtotals for one field, 72–73
 changing the calculation in a value field, 64–67
 count of revenue bug, 63
 displaying a change from a previous field, 69–70
 hiding data, 139
 showing percentage of total, 67
 showing rank, 68
 suppressing subtotals with many row fields, 71–72
 tracking relative importance with the Index op-

tion, 70–71
 tracking running total and percentage of running 

total, 68–69
 tracking the percentage of a parent item, 70
 using % Of to compare one line to another, 67–68

totals
 controlling, 342–343
 including filtered items, 266–268
 moving to the top of the report, 474–475
 referencing in calculated fields or calculated 

items, 141
VBA, 366–368

Cameo, 538–541
cell/s. See also blank cells

clearing, 25
formatting, 73–74
Values area, showing details, 40–41

Change PivotTable Data Source dialog, 36
chart/s

bar, 214–215
column, building, 294–295
cross-filtering, 216
NBA shot, 524–525
pie, building, 296–297

ChatGPT, 491
creating a prompt using a formula, 494–495
generating VBA code, 535–536
retrieving answers, 495–497

Check Compatibility tool, 8–9
checkbox filter, 90–91
Chhabra, Chandeep, 538
classic layout, 27
cleaning up data, 15–19
clearing cells, 25
clearing pivot tables, 39
Close & Load dropdown, 195
Coca Cola, 529
code. See also Python; VBA

M programming language, 546–547
object-oriented, 331
Power Query M, generating, 537–538
Python, 482–483, 485

 combining with formulas, 487
 creating a word cloud, 521–522
 enhancing, 522–523
 generating, 536–537
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creating

TypeScript, creating a pivot table in Excel Online, 
392–394

VBA
 adding text fields to the row area, 387
 category report, 355–358
 creating a new worksheet for each region, 

375–377
 creating a report for top thre customers, 372–373
 creating the Data Model pivot table, 389–390
 creating the Top 5 Markets report, 369–371
 generating, 535–536
 producing a static summary from a pivot table, 

344–345
 setting up data fields, 359–360
 setting up slicers, 383–385

Collie, Rob, 145, 287, 441–442, 448
column/s

adding, 273–275
calculated, adding in the Power Pivot grid, 279
chart, building, 294–295
formula, generating using Copilot, 512–516
headings, 543–544
sorting by another column, 280

Columns area, 5–6
filter/s, 90
icon, 22

Combine Files dialog, 318
Compact layout, 51, 57–58, 77–79, 338
comparing tables, 407–409
CONCATENATEX, 270–271
conceptual filters, 378–381
conditional formatting, 167–169

creating custom rules, 170–175
preprogrammed scenarios, 170
using Copilot, 516–518

configuring, Excel Labs add-in, 492–494
connection types, Power Query, 198, 200
constants, 132, 141
Copilot, 28, 491, 497, 528–529. See also artificial intel-

ligence
Advanced Analysis Using Python, 518–519

 creating a basketball shot chart in Excel, 524–525
 creating a pivot table, 519–521
 creating a word cloud from text, 521–523
 sentiment analysis, 525–526
 solving the knapsack problem, 527–528

Analyze Data, 28–29, 463, 497
 asking questions, 503–506
 versus Copilot, 498
 icon, 497
 pane, 498–500
 suggested analyses, 500–502

analyzing financial statements in OneDrive, 529–531
applying conditional formatting, 516–518
asking questions, 508–512

data storage on OneDrive, 507–508
generating code

 Power Query M, 537–538
 Python, 536–537

generating formula columns, 512–516
generating RegEx, 538–539
hallucination, 498
icon, 508
license, 506
Studio, 532
subscription, 516
versus Analyze Data, 498, 512
writing poetry and lyrics, 539–542

Copy method, 353
copying a pivot table as values, 353–354
cosmetic changes, 44–45. See also format/formatting; 

layout
adding blank lines, 55–56
applying a table style to restore gridlines, 45
built-in themes, 61
changing the number format to add thousands sepa-

rators, 46–47
grand totals, 56–57
replacing blanks with zeros, 47–48

count of revenue bug, 63
Create PivotTable dialog, 20–21
Create Relationship dialog, 179
Create Your Own PivotTable dialog, 463
CreatePivotTable method, 336
creating. See also building your first Data Model

calculated field, 127–130, 132–135
 manually adding to the data source, 124–125
 using a formula, 125–126

calculated item, 135–139
calculated measures, 244–247
calculated members, 247–250
drill-down hierarchy, 216–218
frequency distribution, 417–418
hierarchies, 117–121
offline OLAP cube, 238–241
pivot charts, 152–155
pivot table, 19–22, 449–451

 from the Data Model, 280–281
 flattened, 283–284
 using Copilot with Python, 519–521
 using TypeScript, 391–393
 using VBA. See VBA, building a pivot table

relationships, 209, 261–262
report filter, 28
slicers

 standard, 30–32
 Timeline, 33–34

summary report, 131–132
video from 3D Map, 301–302
word cloud, 521–523
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creating

year-over-year report, 115–117
cross-filtering charts, 216
cross-tabular report

creating using Power Query, 477
 loading data, 478
 sorting and pivoting, 479–480
 summarizing revenue by sector and region, 

478–479
creating using Python, 482–483

 getting your data into a Python data frame, 
483–484

 using PIVOT_TABLE, 484
cube formulas, converting pivot table data to, 224–232
cube functions, 241–243
CUBEMEMBER formula, 224–226
CUBERANKEDMEMBER, 227–229
CUBESET formula, 226–227
CUBESETCOUNT, 228
CUBEVALUE formula, 224–226
custom list, controlling sort order using, 86–89, 398–399
customization, grand totals, 56–57

D
Dalgleish, Debra, 45
D’Angel, 542
dashboards, 205. See also Power BI Desktop
data

animating, 300
card, 299
controlling from multiple data sets, 434–436
converting pivot table data to, 400–401
formatting as a table, 260
geocoding, 292–293
headings, 543–544
loading into Power Query, 478
OLAP, what-if analysis, 251–252
pivot table, converting to cube formula, 224–232

Data Model, 143–147, 178, 259. See also DAX
adding a linked table, 277–278
adding a new table, 182
building your first, 178–181
creating a pivot table from, 280–281, 286
Distinct Count, 264–266
limitations, 182
loading files directly to, 276–277
managing relationships, 181–182
overcoming limitations, 284–286
relationships, 281–282. See also relationship/s
replacing XLOOKUP with, 260–263
unlocking hidden features, 263–264
using in Excel, 385, 388–390

 adding model fields to a pivot table, 387
 adding numeric fields to the Values area, 388
 adding tables, 385–386

 creating a relationship between tables, 386–387
 defining the pivot cache and building the pivot 

table, 387
data sets

combining, 299–300
controlling data from multiple, 434–436
exploding

 to different tabs, 419–420
 to different workbooks, 424–425

transposing, 199–200
writing VBA code to handle any size, 332–333

data source
adding calculated field, 124–125
cleaning up, 15–19
deleting, 406
external. See external data
performance and, 183
preparing, 11, 14–15

 apply field formatting, 14
 avoid repeating groups as columns, 13–14
 avoid storing data in section headings, 12–13
 eliminate gaps and blank cells, 14
 ensuring data is in Tabular layout, 12

refreshing, 7, 35–36
standard chart, 165–167
updating, 36

database
-centric layout, 12
OLAP, 232–233
Stop Word, 521

Date dropdown, 194
date fields, grouping

by months, 113
by week, 114–115

date filters, 98–99, 104–105
DATESMTD, 283
DAX, 143–147, 268–270. See also function/s
defaults, pivot table, 400
deferring layout updates, 38–39
deleting

calculated fields, 148–149
source data worksheet, 406

delimiter, Power Query, 192–193, 201–202
Design tab, PivotTable Styles gallery, 58–59. See also style
dialog

Assign Macro, 312
Browse, 461
Change PivotTable Data Source, 36
Combine Files, 318
Create PivotTable, 20–21
Create Relationship, 179
Create Your Own PivotTable, 463
Edit Default Layout dialog, 27
Field Settings, 342
Format Cells, 47
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Fields pane

Go To Special, 403
Grouping, 107–108
Import Data, 276
Insert Calculated Field, 127–128
Insert Calculated Item, 137–138
Insert Slicers, 30
Insert Timelines, 160
Macro, 315
Manage Relationships, 181–182
New Calculated Measure, 245–246
New Calculated Member, 248–249
New Set, 254
PivotTable From Table or Range, 264
Publish to Power BI, 220–221
Record Macro, 308–309
Replace Values, 481
Report Connections, 31–32
Select Table, 185
Show Detail, 51
Subtotal, 354
Value Field Settings, 64–67, 366–368. See also Values 

area, changing the calculation     in a field
Dickerman, Howie, 62, 469
dimensions, OLAP cube, 236
Distinct Count, 264–266
docking the Fields pane, 79
documenting, formulas, 150
drag and drop functionality, 27
Drill Down/Drill Up icons, adding to ribbon, 117
drill-down hierarchy, creating, 216–218
dropdown

Areas section, 81
Close & Load, 195
Date, 194
Effect, 301
Filters area, 100
Label, Date filters, 98–99
Related Column (Primary), 179

E
Edit Default Layout dialog, 27
editing

calculated fields, 148–149
MDX (multidimensional expressions), 253–257

Effect dropdown, 3D Map, 301
End With statement, 334
Escobar, Miguel, 538
Escobar, Miguel, Master Your Data is For Data Monkey, 

287
ETL (extraction, transformation, and loading), 189, 192. 

See also Power Query
Excel, 503–506. See also Copilot; VBA; workbooks

32-bit, 285
Archaeology, 62–63
building a shell report, 452–453

creating slicers, 383
Flash Fill, 274
formatting limitations, 159
Go To Special feature, 403–404
PivotTable Settings task pane, 466–469
preparing data, 206
using the Data Model, 385, 388–390

 adding model fields to a pivot table, 387
 adding numeric fields to the Values area, 388
 adding tables, 385–386
 creating a relationship between tables, 386–387
 defining the pivot cache and building the pivot 

table, 387
VBA, enabling, 328–329
YouTube videos, summarizing using AI, 532–534

Excel Labs add-in, installing, 492–494
Excel Online, 391, 459–460

changing pivot table options, 465–469
creating a pivot table, 462–465
default aggregation, 484
pivot table features, 469
PivotTable ribbon tab, 465–466
signing in, 460–462

exploding data sets
to different tabs, 419–420
to different workbooks, 424–425

expressions, multidimensional, 244
external data, 177

building a pivot table using, 183
Microsoft Access, building a pivot table using, 

183–186
SQL Server, building a pivot table using, 186–189

F
Field Settings dialog, 342
field/s

adding to a report, 22
adding to Filters area, 99
calculated. See calculated fields
date

 grouping by months, 113
 grouping by week, 114–115

formatting, 14
numeric

 grouping, 107–108
 grouping manually, 111–113

page, 373
rank number, adding to a pivot table, 404–405
renaming, 48–49
text

 adding using VBA, 387
 grouping, 109–111

Fields pane, 79
choosing multiple items from a filter, 100
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Fields pane

docking/undocking, 79
minimizing, 79–80
Power BI Desktop, 207
rearranging, 80–81

filling blank cells, 401
Repeat All Item Labels option, 402
using Go To Special, 403–404

FILTER, 231–232
filtered items, including in totals, 266–268
filter/s. See also slicer/s

applying using Copilot, 517–518
checkbox, 90–91
conceptual, 378–381
custom, 409–411
label, 93–94
report, creating, 28
for row and column fields, 90
search, 381–382
search box, 92
slicers, 102–104
Top 10, 96–97, 410–411
update bug, 97
Value, 94–96
VBA, 377–378
xlCaptionContains, 382

Filters area, 6, 99
adding fields, 99
choosing one item from a filter, 100
replicating a pivot table report for each item in a 

filter, 100–102
FinalRow variable, 332–333
fine-tuning, 3D Map, 299
Flash Fill, 274
flat table, 183
flattened pivot table, creating, 283–284
fonts, resizing, 159
form controls

creating a user interface, 311–313
scrollbar, 314–316

FORMAT, 279
Format Cells dialog, 47
format/formatting. See also layout

cells, 73–74
conditional, 167–169

 creating custom rules, 170–175
 preprogrammed scenarios, 170
 using Copilot, 516–518

fields, 14
limitations of Excel, 159
number

 adding thousands separators, 46–47
 changing the default, 351–352
 multiple, 412–413

pivot tables
 individual values, 413–415
 sections, 415–417
 using VBA, 338–340, 354

slicers, 437–439
formula/s

combining with Python code, 487
creating a calculated field, 125–126
creating a ChatGPT prompt, 494–495
cube, converting pivot table data to, 224–232
CUBEMEMBER, 224–226
CUBESET, 226–227
CUBEVALUE, 224–226
documenting, 150
generating columns using Copilot, 512–516
member_expressions, 225
preventing multiple calculations, 495

frequency distribution, creating, 417–418
function/s

CALCULATE, 282–283
CONCATENATEX, 270–271
cube, 241–243
CUBERANKEDMEMBER, 227–229
CUBESETCOUNT, 228
DATESMTD, 283
FILTER, 231–232
FORMAT, 279
GETPIVOTDATA, 224. See also GetPivotData
GROUPBY

 arguments, 472
 creating a summary using, 472–473
 pros and cons, 477
 showing subtotals for multiple row fields, 

475–476
 sorting the results of, 474

Index, 70–71
LABS.GENERATIVEAI, 492, 495–497
LET, 231
MAKEARRAY, 229–231
MONTH, 279
OFFSET, 449
pd.Grouper, 488–489
pivot_table, 484–487
PIVOTBY, 471–472, 476–477

 pros and cons, 477
 sorting the results of, 474
 syntax, 476

SUM, 360
TEXTSPLIT, 522
TEXT, 279
time intelligence, 282–283
using in a calculated field or calculated item, 139, 141
VLOOKUP, 202–203, 279
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layout

XLOOKUP, replacing with the Data Model, 260–263
YEAR, 279
Funnel icon, 3D Map, 299
Fuss, Stacie, iii

G
Gainer, Dave, 441
geocoding, 292–293
Get and Transform Data tools, 545
GetPivotData, 446–447

avoiding the problem, 442–445
populating a shell report, 454–457
preventing the problem, 445
turning off, 445–446
using to solve pivot table annoyances, 447–448

GETPIVOTDATA, 224
Girvin, Mike, 538
Girvin, Mike, The Transformative Magic of Power Query M 

Code in Excel and Power BI, 197
Go To Special feature, 403–404
Google Sheets, 459
Govier, Roger, 474
GP% (gross profit percentage), 512–514
grand totals, customizing, 56–57
Great Circle calculation, 515
Group method, 349–350
GROUPBY, 471–472

arguments, 472
creating a summary using, 472–473
pros and cons, 477
showing subtotals for multiple row fields, 475–476
sorting the results of, 474

Grouping dialog, 107–108
groups/grouping

calculated, 365–366
date fields

 by months, 113
 using Python, 487–489
 by week, 114–115

numeric fields, 107–108, 111–113
text fields, 109–111

H
hallucination, 498
hard data, converting pivot table data to, 400–401
Haversine formula, 515
headings, 543–544
heat maps, 297–298
hiding data, 139
hierarchy/ies

creating, 117–121
drill-down, 216–218

OLAP cube, 236
pivot table, 107

hierarchy
high-to-low sorting, based on revenue, 82–85
Hopkins, Wyn, 62, 459

I
icon

Analysis, 214
Analyze Data, 497
Copilot, 508
Drill Down/Drill Up, adding to ribbon, 117
Funnel, 299
Insert, 314
Insert Python, 482
PivotTable ribbon tab, 465–466
Report, 211
up and down arrow, 296

icons, Columns and Rows, 22
implicit measure, 145
Import Data dialog, 276
importing data into Power Bi, 206–207. See also external 

data
INDEX, 70–71
Insert Calculated Field dialog, 127–128
Insert Calculated Item dialog, 137–138
Insert icon, 314
Insert Python icon, 482
Insert Slicers dialog, 30
Insert Timelines dialog, 160
installing, Excel Labs add-in, 492–494

J-K
James, Lebron, 524
Jelen, Bill, Power Pivot for the Data Analyst, 280
Jelen, Mary Ellen, iii
joining tables, 287–290

knapsack problem, solving, 527–528
Kughen, Rick, xix

L
Label dropdown, Date filters, 98–99
label filter, 93–94
LABS.GENERATIVEAI, 492, 495–497
Laporte, Leo, xxi 
layers

3D Map, 294
adding to a pivot table, 25

layout. See also cosmetic changes
classic, 27
clearing, 39
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layout

database-centric, 12
deferring updates, 38–39
drag and drop functionality, 27
report, 23–25, 50

 Compact, 51, 57–58, 77–79
 Outline, 52–53
 Tabular, 53–54

spreadsheet, 11
Tabular, 12, 348

legacy wizards, 184
LET, 231
levels, OLAP cube, 236
license

Copilot, 506
TypeScript, 391

LLMs (large language models), 491
loading data into Power Query, 478
lyrics, using Copilot to write, 539–542

M
“M” language, 195, 537–538, 546–547
Macro dialog, 315
macro/s, 307–308. See also VBA

adding functionality, 313–314
buttons, 316
creating using Power Query, 317–325
enabling on Excel workbooks, 329
pivot field restriction, 423
pivot table restriction, 421
recorder, 308–309, 331
TypeScript, 391
user interface, creating with form controls, 311–313

MAKEARRAY, 229–231
Manage Relationships dialog, 181–182
manual sorting, 85–86
MDX (multidimensional expressions), 244

editing, 253–257
testing, 257

measures, 123, 143–147, 388
calculated, 243, 244–247
calculating the median, 268–270
dimension, 237
implicit, 145
slicing, 237

median, calculating using DAX measures, 268–270
member_expressions, 225
members

calculated, 243, 247–250
OLAP cube, 236

memory
pivot cache, 7
pivot table limitations, 7–8
RAM, 183 

Merge query, 430
Meta VR, 497
method/s, 331

AddFields, 336–337
AutoShow, 369–371
AutoSort, 351
Copy, 353
CreatePivotTable, 336
Group, 349–350
RepeatAllLabels, 347
ShowPages, 374

Microsoft 365, formatting cells, 73–74
Microsoft Access, importing data into a pivot table, 

183–186
Microsoft Edge, 532–534
minimizing, Fields pane, 79–80
MONTH, 279
multiple ranges, 177

N
Nadella, Satya, 459, 491
named ranges, using in a calculated field or calculated 

item, 141
NBA shot chart, 524–525
New Calculated Measure dialog, 245–246
New Calculated Member dialog, 248–249
New Set dialog, 254
Nitin, Dr., 529
number format

adding thousands separators, 46–47
changing the default, 351–352
forcing multiple within a pivot table, 412–413

numeric fields
grouping, 107–108
grouping manually, 111–113

O
object

-oriented code, 331
pivot cache, 336
PivotField, 422

PivotTable, 420
variable, 333–334

offline OLAP cube, creating, 238–241
OFFSET, 449
OLAP (online analytical processing), 232–233

calculated measures, creating, 244–247
calculated members, creating, 247–250
cube

 connecting to, 233–235
 functions, 241–243
 MDX (multidimensional expressions), 244
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 offline, creating, 238–241
 structure, 236–237

managing calculations, 250–251
pivot table

 adding calculations, 243
 limitations, 238

what-if analysis, 251–252
OneDrive, 507–508, 529–531
one-to-many relationship, 281–282
OpenAI, 491
order of operator precedence, 140–141
Outline layout, 52–53
Ozgur, Suat, xix, 539 

P
page fields, 373
Paranjape, Nitin, 529
PD.GROUPER, 488–489
percentage

change, 426–428
gross profit, 512–514
tracking, 70

performance
data set size and, 183
RAM and, 183

Photoshop, 302
pie chart, building, 296–297
pivot cache, 7, 336, 387

creating for a pivot table, 37
refreshing, 35
sharing, 36–38

pivot chart/s, 151–152
alternatives, convert pivot table into hard values, 

164–165
creating, 152–155
creating without a pivot table, 175–176
distributing a picture of, 165
pivot field buttons, 155–156
report, creating, 159–162
rules, 156

pivot field buttons, 155–156
pivot table/s, 1, 4. See also Data Model; Excel Online

adding a rank number field, 404–405
adding layers, 25
applying a style to restore gridlines, 45
AutoFilter, 409–411
automatically expanding the data range, 406–407
backwards compatibility, 7
border, applying, 62–63
building with external data

 Microsoft Access, 183–186
 SQL Server, 186–189

Columns area, 5–6
comparing tables, 407–409

conditional formatting, 167–169
 creating custom rules, 170–175
 preprogrammed scenarios, 170

converting
 to hard data, 164–165, 400–401
 to values, 54–55, 343–346

copying as values, 353–354
creating, 19–22, 449–451

 from the Data Model, 280–281, 286
 in Excel Online, 462–465
 using Copilot with Python, 519–521
 using TypeScript, 391–393
 using VBA, 534–536. See also VBA, building a 

pivot table
creating a frequency distribution, 417–418
creating a pivot cache, 37
data area, filling blank cells, 340
defaults, 400
driving multiple from one set of slicers, 105–107
exploding data sets

 to different tabs, 419–420
 to different workbooks, 424–425

Fields list, 22, 24
Filters area, 6
flattened, 283–284
forcing two number formats, 412–413
formatting individual values, 413–415
formatting sections of a, 415–417
hierarchies, 107, 117–121
inserting a calculated field, 126–127
median, calculating using DAX measures. See DAX
memory limitations, 7–8
OLAP

 adding calculations, 243
 limitations, 238
 MDX (multidimensional expressions), 244

options, Excel Online, 465–469
Python, 484–489
rearranging, 25–27
reasons to use, 2–3
refreshing, 241, 448

 automatically, 396
 multiple at the same time, 396

relocating, 39–40
renaming, 32
report, 1, 11. See also report/s

 adding fields, 22
 analyzing activity by market, 34–35
 laying out, 23–25
 slicers, 30

restrictions, 420–422
Rows area, 5
sorting, 81–82

 high-to-low sequence based on revenue, 82–85 
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 manual, 85–86
 using a custom list, 86–89

subtotals, removing, 401
Values area, 4–5
when to use, 3–4

PIVOT_TABLE, 484–487
PIVOTBY, 471–472, 476–477

pros and cons, 477
sorting the results of, 474
syntax, 476

PivotField object, 422
PivotTable From Table or Range dialog, 264
PivotTable object, 420
PivotTable Settings task pane, 466–469
poetry, using Copilot to write, 539–542
populating a shell report with GetPivotData, 454–457
Power BI, 205, 207, 210, 503

Ask a Question, 503
building an interactive report, 211
creating a drill-down hierarchy, 216–218
cross-filtering charts, 216
defining synonyms, 211
designing for the mobile phone, 220
Fields panel, 207
getting started with, 205–206
importing data, 206–207
preparing data, 209–210
preparing data in Excel, 206
publishing to, 220
publishing to a workspace, 220–221
report, 208
visualizations, 207–208

 building, 211–216
 importing, 218–219

Power Pivot, 223, 259, 260, 286
adding calculated columns, 279
handling complicated relationships, 281–282

Power Query, 143–147, 184, 189
adding a new column, 273–275
Advanced Editor, 197
applied steps, 195–197, 275
cleaning and summarizing data, 194–195
connection types, 198, 200
creating a cross-tab, 477

 loading data, 478
 sorting and pivoting, 479–480
 summarizing revenue by sector and region, 

478–479
creating a macro, 317–325
data transformation, 192
Editor, 16–17, 192
ETL (extraction, transformation, and loading), 189
joining tables, 287–290
loading results to the Data Model, 276–277

performing a query, 190–191
processing big data, 271–273
pros and cons, 482, 489
refreshing the data, 198
transposing a data set, 199–200
two-way VLOOKUP, 428–433
unpivoting, 545–547

 from a delimited cell to new rows, 555–557
 from two rows of headings, 548–555

versus VBA Macro Recorder, 275–276
working with delimiters, 192–193, 201–202

preparing, data source, 11, 14–15
apply field formatting, 14
avoid repeating groups as columns, 13–14
avoid storing data in section headings, 12–13
eliminate gaps and blank cells, 14
ensuring data is in Tabular layout, 12

primary key, 179–180
prompt

asking Copilot questions, 508–512
creating using a formula, 494–495

Publish to Power BI dialog, 220–221
Puls, Ken, 538
Puls, Ken, Master Your Data is For Data Monkey, 197, 287
Python

code. See code, Python
Copilot, 518–519

 creating a basketball shot chart in Excel, 524–525
 creating a pivot table, 519–521
 creating a word cloud from text, 521–523
 sentiment analysis, 525–526
 solving the knapsack problem, 527–528

creating a cross-tab, 482–484
enhancing generated code, 522–523
grouping dates in pivot tables, 487–489
PD.GROUPER, 488–489
PIVOT_TABLE, 484–487
subscription, 482

Q
query. See also Power Query

Append, 430–433
Merge, 430

R
RAM, and performance, 183
rank options, 68, 404–405
rearranging

Fields pane, 80–81
pivot table, 25–27

rearranging a pivot table, 25–27
Record Macro dialog, 308–309
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recording a macro, 308–310
reducing the size of pivot table reports, 406
refreshing

data source, 7, 35–36
pivot tables, 241, 448

 automatically, 396
 multiple at the same time, 396

Power Query data, 198
RegEx, generating, 538–539
region maps, 297–298
Related Column (Primary) dropdown, 179
relationship/s

creating, 209, 261–262
managing in the Data Model, 181–182, 386–387
one-to-many, 281–282
primary key, 179–180
table, defining, 179, 278

relative index number, 138
removing

blank cells, 14, 350–351
subtotals from a pivot table, 401

renaming
fields, 48–49
pivot table, 32

Repeat All Item Labels option, 402
RepeatAllLabels method, 347
Replace Values dialog, 481
replacing XLOOKUP with the Data Model, 260–263
report/s, 1, 11

adding fields, 22
analyzing activity by market, 34–35    category, 

355–358
creating from a pivot chart, 159–162
cross-tabular, creating

 using Power Query, 477, 478–479,       479–480
 using Python, 482–484

filter, 28, 100–102
layout, 23–25, 50

 Compact, 51, 57–58, 77–79
 Outline, 52–53
 Tabular, 53–54

moving totals to the top of, 474–475
Power BI Desktop, 208, 211, 220
reducing the size of, 406
shell

 building, 452–453
 populating with GetPivotData, 454–457

showing revenue by category, 346–348
slicers, 30–32
summary, creating, 131–132
Top 5 Markets, 369–371
top-five, 96–97
with two or more data fields, 358–360
updating, 457–458

year-over-year, creating, 115–117
Report Connections dialog, 31–32
Report icon, 211
reporting text in the Values area, 270–271

resizing, fonts, 159
restrictions

pivot field, 422–423
pivot table, 420–422

ribbon
adding Drilll Down/Drill Up icons, 117
Excel Online, icons, 465–466
PivotTable Analyze tab, 36

Rows area, 5
filters, 90
icon, 22

rules
calculated field, 141–143
calculated item, 148
conditional formatting, 170–175
pivot chart, 156–159

running total calculations, 68–69

S
Salas, Pito, xxvi
scenes, 300–301
scrollbar

testing, 315, 316
form control, 314–316

search box, applying filters, 92
search filter, 381–382
security, workbook, 309–311
Sekas, Kim, iii
Select Table dialog, 185
sentiment analysis, 525–526
sets, 253–257
settings, 3D Map, 298
sharing, pivot cache, 36–38
shell report

building, 452–453
populating with GetPivotData, 454–457

Show Detail dialog, 51
Show Report Filter Pages button, 419
ShowDetail property, 371–373
ShowPages method, 374
signing in to Excel Online, 460–462
slicer/s, 6, 30, 102–104

backwards compatibility, 7
cache, 383
controlling data from two different data sets, 434–436
driving multiple pivot tables from, 105–107
formatting, 437–439
setting up using VBA, 382–385
standard, creating, 30–32
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Timeline
 creating, 33–34
 filtering by date, 104–105
 inserting into a pivot chart, 160–161

slicing the measures, 237
solving the knapsack problem, 527–528
sorting, 81–82

GROUPBY/PIVOTBY results, 474
high-to-low sequence based on revenue, 82–85
manual, 85–86
one column by another column, 280
Power Query, 479–480
unique order, 397
using a custom list, 86–89, 398–399
using Copilot, 516–518
using VBA, 351

source data, converting into an Excel table, 406–407
spreadsheet

inserting a scrollbar form control, 314–316
layout, 11

SQL Server Analysis Services, 223
SQL Server, importing data into a pivot table, 186–189
standard chart. See also pivot chart/s

creating, 164–167
data source, 165–167

With statement, 334
Stop Words, 521
store map, 302–304
Stride, Roy, 538–541
structure, OLAP cube, 236–237
style

applying to a pivot table, 45
built-in themes, 61
customizing, 59–60
slicer, 437–439

subscription, 506
Copilot, 516
Python, 482

Subtotal dialog, 354
subtotals

adding and removing, 71
adding multiple for one field, 72–73
adding to get page breaks, 354–355
removing from a pivot table, 401
suppressing, 71–72, 352

SUM, 360
Sum of Revenue, renaming to Revenue, 49
summary calculations

adding and removing subtotals, 71
adding multiple subtotals for one field, 72–73
changing the calculation in a value field, 64–67
count of revenue bug, 63

displaying a change from a previous field, 69–70
hiding data, 139
Power Query, 478–479
showing percentage of total, 67
showing rank, 68
suppressing subtotals with many row fields, 71–72
tracking relative importance with the Index option, 

70–71
tracking running total and percentage of running 

total, 68–69
tracking the percentage of a parent item, 70
using % Of to compare one line to another, 67–68

summary report, creating, 131–132
Suno.com, 542
Supernatural Fitness, 497
synonyms, defining in Power BI Desktop, 211

T
table/s. See also relationship/s

adding to Data Model, 182, 385–386
comparing using a pivot table, 407–409
converting source data into, 406–407
flat, 183
formatting data as, 260
joining, 287–290
linked, adding to Data Model, 277–278
relationships, 260

 creating, 209, 261–262
 defining, 179, 278
 managing in the Data Model, 181–182

Tabular layout, 12, 53–54, 338, 348
Test MDX button, 246
testing

MDX (multidimensional expressions), 257
scrollbar, 315, 316

TEXT, 279
text

creating a word cloud, 521–523
sentiment analysis, 525–526
in the Values area, reporting, 270–271

text box, adding to pivot chart, 159
text fields, grouping, 109–111
TEXTSPLIT, 522
themes, built-in, 61
time intelligence functions, 282–283
time scrubber, 300
Timeline slicer, 6

backwards compatibility, 7
creating, 33–34
filtering by date, 104–105
inserting into a pivot chart, 160–161
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tool/s. See also Power Pivot; Power Query
calculated members, 243
Check Compatibility, 8–9
Get and Transform Data, 545
mapping, 293. See also 3D Map
OLAP, 223
VBA, 330–331
web scraping, 191

Top 5 Markets report, 369–371
Top 10 filter, 96–97, 266–268, 410–411
totals

controlling, 342–343
including filtered items, 266–268
moving to the top of the report, 474–475
referencing in calculated fields or calculated items, 

141
tour, 3D Map, 300–301
transposing a data set, 199–200
trusted location, 309–310
turning off GetPivotData, 445–446
Twinbox.AI, 532
two-way VLOOKUP, 428–433
TypeScript, creating a pivot table, 391–393. See also Excel 

Online

U
Umlas, Bob, iii
undocking the Fields pane, 79
unique order sort, 397
unlocking hidden features with the Data Model, 263–264
unpivoting, 545–547

from a delimited cell to new rows, 555–557
from two rows of headings, 548–555

up and down arrow icons, 296
updates

data source, 36
layout, deferring, 38–39
report, 457–458

user interface, creating with form controls, 311–313

V
Value Field Settings dialog, 64–67

Show Values As tab, 366–368
Value Filters, 94–96
values

converting a pivot table to, 54–55, 343–346
copying a pivot table as, 353–354
formatting, 413–415

Values area, 4–5
adding thousands separators, 46–47
changing the calculation in a field, 64–67

 adding and removing subtotals, 71
 adding multiple subtotals for one field, 72–73
 displaying a change from a previous field, 69–70
 showing percentage of total, 67
 showing rank, 68
 suppressing subtotals with many row fields, 71–72
 tracking relative importance with the Index op-

tion, 70–71
 tracking running total and percentage of running 

total, 68–69
 tracking the percentage of a parent item, 70
 using % Of to compare one line to another, 67–68

constants, 132
fields, renaming, 48–49
reporting text, 270–271
showing details for any cell in, 40–41

variable/s
FinalRow, 332–333
object, 333–334

VBA, 313, 316, 317, 327. See also GetPivotData; Visual Basic 
Editor
adding subtotals to get page breaks, 354–355
building a pivot table, 335–337

 adding fields to the data area, 337–338
 formatting, 338–340

calculated fields, 362–363
calculated groups, 365–366
calculated items, 363–365
calculations, 360–362, 366–368
changing the default number format, 351–352
conceptual filters, 378–381
controlling sort order, 351
controlling totals, 342–343
converting pivot table to values, 343–346
copying a finished pivot table as values to a new 

workbook, 353–354
creating a report showing showing revenue by cat-

egory, 346–348
creating reports for each region or model, 373–377
enabling on Excel, 328–329
End With statement, 334
exploding data sets to different workbooks, 424–425
filling blank cells

 in the data area, 340
 in the row area, 341

generating a pivot table, 534–536
handling final formatting, 354
Macro Recorder, versus Power Query, 275–276
manually filtering two or more items, 377–378
method, 331

 AddFields, 336–337
 AutoShow, 369–371
 AutoSort, 351
 Copy, 353
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 CreatePivotTable, 336
 RepeatAllLabels, 347
 ShowPages, 374

object-oriented code, 331
page fields, 373
preventing errors from inserting or deleting cells, 341
on previous versions of Excel, 334–335
removing blank cells, 350–351
rolling daily dates up to years, 348–350
search filter, 381–382
setting up slicers, 382–385
ShowDetail property, 371–373
With statement, 334
suppressing subtotals for multiple row fields, 352
tool/s, 330–331
using the Data Model in Excel, 385, 388–390

 adding model fields to a pivot table, 387
 adding numeric fields to the Values area, 388
 adding tables, 385–386
 creating a relationship between tables, 386–387
 defining the pivot cache and building the pivot  

table, 387
variable/s

 FinalRow, 332–333
 object, 333–334

writing code to handle a data range of any size, 
332–333

video, creating from 3D Map, 301–302
Visual Basic Editor, 316, 329–330
visualizations, Power BI Desktop, 207–208

building, 211–216

importing data, 218–219
VLOOKUP, 202–203, 279. See also two-way VLOOKUP

W
web scraping tool, 191
Webb, Chris, 229
what-if analysis, 251–252
when to use a pivot table, 3–4
word cloud, creating, 521–523
workbook/s

18-CocaColaFinancialStatements.xlsx, 529
copying a pivot table as values to, 353–354
enabling macros to run on, 329
exploding data sets to, 424–425
security, 309–311

worksheet
creating using VBA, 375–377
source data, deleting, 406

writing poetry and lyrics using Copilot, 539–542

X-Y-Z
xlCaptionContains filter, 382
XLOOKUP, replacing with the Data Model, 260–263
YEAR, 279
year-over-year report, creating, 115–117
YouTube, summarizing Excel videos using AI,  

532–534
zeros, replacing blank cells with, 47–48
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